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LEGAL DISCLAIMER

By using ANSTO’s CORIS360® radiation imaging system (Product) and ANSTO’s proprietary CORIS360® Radiation Imaging 
Software (Software), you agree to be bound by the content of this disclaimer, the Terms and Conditions – Sale of CORIS360®, 
as well as any terms accepted when you first accessed the Software.

Your use of the CORIS360® is at your own risk. You must evaluate, and bear all risks associated with, the use of any tangible 
or intangible material produced or output generated through your use of the CORIS360® including reliance on the accuracy, 
completeness, suitability for any purpose or usefulness of any such material produced or output generated through your use 
of the CORIS360®.

ANSTO has prepared this document for use by you, as the purchaser, in connection with the CORIS360®. No party, other than 
the purchaser, may rely on this document without the express consent of ANSTO and ANSTO does not accept any responsibility 
for any third party who may rely upon or use this document or the CORIS360®. 

DISCLAIMER OF WARRANTY

Except as provided for in the Terms and Conditions – Sale of CORIS360®, ANSTO does not guarantee or warrant that any 
tangible or intangible material produced or output generated through your use of the CORIS360® will be suitable or fit for any 
particular purpose of the uses to which you may put any such material produced or output generated through your use of the 
CORIS360® and to the maximum extent permitted by law ANSTO accepts no liability for the manner in which the CORIS360® 
may operate, or results that can be received from the CORIS360®.

To the maximum extent permitted by applicable law:

a) the Software is provided “as is” and “as available”, with all faults and without warranty of any kind.
b)  all conditions, warranties, undertakings or representations, express or implied, arising by statute general law or otherwise 

are expressly disclaimed and excluded. 
c)  ANSTO disclaims and excludes all statutory and implied warranties, including without limitation, warranties of 

merchantability, accuracy, non-infringement of third party rights, and fitness for a particular purpose and warranties against 
hidden or latent defects. 
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d) ANSTO has no liability to you and is released by you from any and all liability:
 i. whether in contract, tort (including negligence and breach of statutory duty) in relation to the Software; 
 ii. including but not limited to liability for: 
  A. personal injury or death;
  B. damage to property;
  C. any lost revenue, lost opportunity, increased costs or expenses, lost profits or lost business; 
  D. loss of data;
  E. any special loss or damage;
  F. any indirect, incidental or consequential loss or damage of any nature.

INTELLECTUAL PROPERTY NOTICES

CORIS360® is a registered trademark of the Australian Nuclear Science and Technology Organisation.

Removal, concealment, or alteration of any trade marks, business names or indicia, proprietary notices (including trade mark 
and copyright notices) that may be affixed to or contained within the Software, Product or this User Guide is prohibited.

ANSTO retains all rights, title and interest in the intellectual property in the Software and the Product (as defined in the Terms 
and Conditions – Sale of CORIS360®) and this User Guide. Except where specified, ANSTO does not transfer ownership or licence 
any intellectual property subsisting in the Product, the Software or this User Guide.

You must not seek, claim or take any steps to invalidate or prejudice ANSTO’s Intellectual Property rights in the Product, 
the Software or this User Guide.

Unless otherwise permitted in the Terms and Conditions – Sale of CORIS360®, it is prohibited to:

a)  copy, adapt, translate, manufacture or otherwise exercise any intellectual property rights in any of ANSTO’s patents, 
trade marks, service marks, logos, industrial designs or copyright materials; and

b)  to rent, lease, lend, sell, redistribute, or sublicense the Software, the Product or this User Guide without the express written 
consent of ANSTO.

To the extent that any open source code may be made available at the same time as the Software, such open source code is 
provided as a courtesy only and is subject to the terms of the relevant open source licence(s) which govern the use of open 
source software. 

This product contains patented technology. Please refer to https://www.ansto.gov.au/patents for a full list of patents.

https://www.ansto.gov.au/patents
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General Safety Information

Do not install substitute parts or perform any unauthorised modification to this device. Contact the CORIS360® customer 
support team for any servicing or repairs to ensure the safety features are maintained. If required, contact the customer support 
team at support@coris360.com.

Use the device only as specified. Review the following safety precautions to avoid injury and prevent damage to this device. 
Carefully read all instructions and retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the device, it is essential that the user follows generally accepted safety procedures in addition 
to the safety precautions specified in this manual.

Only qualified personnel from the CORIS360® customer support team should repair, service or perform maintenance on 
the device.

This device is classified as Group 1 Class B ISM (Industrial, Scientific and Medical) equipment. This means the device does not 
intentionally generate radio-frequency energy and the device is suitable for use in domestic and residential areas, and can be 
connected to public mains power.

Do Not Insert Power Supply into 
Device while Powered

To avoid electric shock, sparking or a fire hazard, do not insert the power supply into 
this device while the power supply is powered.

Do Not Remove Covers To avoid electric shock or fire hazard, do not operate this device with covers or 
panels removed.

Do Not Operate in 
Wet Conditions

To avoid electric shock and ensure proper functioning of this device, do not operate 
this device in wet conditions (in accordance with IP54 rating).

Use Care When Lifting 
the Device

Use care and follow proper lifting technique when lifting and carrying the device. 
The device is provided with a handle at the top of the device and hand slots at 
the bottom.

Injury Precautions
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Product Damage Precautions

Safety Terms and Symbols

Use Proper Power Supply Use only the power supply provided with this device. Do not operate this device 
from any other power supply, and operate power supply in dry conditions only.

Do Not Plug or Unplug Detector 
while Device is Switched On

To avoid damage to the detector, do not plug or unplug the detector from the 
device while the device is powered on.

Do Not Operate if 
Suspected Failures

If there is suspected damage to the device, do not operate or power the device and 
have it inspected by qualified CORIS360® personnel.

Do Not Operate Outside of 
Operating Temperature

To avoid damage to the device and ensure optimal performance, do not operate the 
device outside of the 5°C – 40°C (41°F – 104°F) temperature range.

Use Care When Handling 
the Device

Use care when handling and moving the device. Dropping or rapidly shaking the 
device can result in damage to the device.

WARNING The WARNING sign indicates a potential hazard. It calls attention to a procedure, 
practice or condition which, if not followed, could possibly cause bodily injury 
or death. If a WARNING is indicated, do not proceed until its conditions are fully 
understood and met.

CAUTION The CAUTION sign indicates a potential hazard. It calls attention to a procedure, 
practice or condition which, if not followed, could possibly cause damage to 
equipment. If a CAUTION is indicated, do not proceed until its conditions are fully 
understood and met.

Standards Certification

CORIS360® has been certified in accordance with the following standards:

• IEC 61010-1: Safety requirements for electrical equipment for measurement, control, and laboratory use 
• EN 61326-1: Electrical equipment for measurement, control and laboratory use – EMC requirements 
• IEC 62262: Degrees of protection provided by enclosures for electrical equipment against external mechanical impacts
• CE certified
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1.   BACKGROUND

CORIS360® is a gamma-ray imaging system which has been developed and built at ANSTO. The technology behind CORIS360® 
is based on the theory of compressed sensing, which enables gamma-ray images to be acquired in a fraction of the samples 
typically required by conventional imaging techniques. 

CORIS360® can identify and locate the presence of gamma emitting radionuclides by creating a 
360° horizontal × 90° vertical gamma image, overlaid onto a panoramic optical image covering the same field of view. 
CORIS360® uses a spectroscopic detector which allows for the identification of gamma emitting radionuclides in the 40 keV to 
>3 MeV range. These detectors are also able to detect the presence of neutrons.

CORIS360® has a novel dual cylindrical mask configuration that surrounds a single central detector. The gamma image 
acquisition occurs by collecting gamma spectra over a series of individual samples. The dual masks shield the incident gamma 
radiation, with the rotation of the masks creating a series of unique mask patterns. A gamma spectrum is recorded at each mask 
position, building up a series of encoded gamma spectrum samples which can then be reconstructed into a gamma image.
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2.1.  Equipment List

CORIS360® comes with the following items. For any issues regarding equipment, please contact the customer support team 
at support@coris360.com. A digital copy of this user guide can also be accessed through the CORIS360® Radiation Imaging 
software by clicking Help > Manual from the menu bar at the top of the window.

2.  EQUIPMENT SET UP

CORIS360® Imager

CORIS360® Imaging and processing software

Tripod

Ruggedised carry case

Two detectors

Power and data cables

152Eu calibration puck

Hex Key
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2.2.  Operating Requirements

Power Supply 100 VAC – 240 VAC (47 Hz – 63 Hz) Input
Provides 24 VDC and minimum 90 W to CORIS360®

Operating Temperature 5 °C – 40 °C (Ambient) | 41 °F – 104 °F (Ambient)

Dose Rate Range CLLBC15 detector
<0.1 µSv/h – 2 mSv/h  (<0.01 mrem/h – 200 mrem/h)

CLLBC05 detector
<0.1 µSv/h – 40 mSv/h  (<0.01 mrem/h – 4000 mrem/h)

Both for 137Cs source

Minimum Computer 
Specifications

Processor:    Intel Core i5 6th Generation (or equivalent)
Memory:     4 GB RAM
Hard Drive:    Solid State with 1 GB available
Operating System:  Windows 7 or later (64 Bit) 
Display:     14” screen, 1920 x 1080 resolution
Network Interface:  Ethernet or Wi-Fi

Humidity Range Max 70% relative humidity, non-condensing

Altitude Range Max 3000 m

The operating requirements for CORIS360® and the connected computer are as follows: 
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CAUTION. Dropping or rapidly shaking the system can damage the system. To avoid this, ensure care is 
always used when handling or moving the system.

To remove CORIS360® from the transportation case, it is recommended that proper lifting technique is always used. CORIS360® 
has a weight of 15 kg  (33 lbs).  When lifting the device out of the case, always use two hands, placing one hand at the top and 
bottom of the system. Do not attempt to lift or rotate the system using the removable circular lid at the top of the device.

NOTE. Whenever CORIS360® is being transported, ensure that any detector inside the device has been removed and placed 
in its corresponding location in the transportation case.

2.3.  Removing CORIS360® from the Transportation Case

WARNING. Incorrect lifting technique when handling the system can result in injury. To avoid this, ensure 
proper lifting technique is used at all times when lifting and carrying the system.
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CAUTION. Dropping or rapidly shaking the system can damage the system. To avoid this, ensure care is 
always used when handling or moving the system.

2.4. Position CORIS360® on the Tripod 

CORIS360® is attached to the tripod via the provided tripod mount. Ensure the mount is in 
the unlocked position prior to placing the system on top. Lock the system to the tripod by 
closing the mount latch.

NOTE. If the tripod needs to be moved while attached to CORIS360®, always detach the 
device and tripod and move separately. Moving the two items while attached can be 
unstable.

The ideal placement for CORIS360® is on a tripod 1 m – 1.5 m off the ground, with nothing 
obstructing the 360° horizontal × 90° vertical view surrounding the device. It is best 
practice that there are no objects within a 1 m radius of the device. If necessary, due to 
operational constraints, CORIS360® may be placed close to objects (such as a wall, or in 
an enclosed space). However, this may lead to unrealistic image artefacts in the optical 
image. Importantly, it should be noted that device placement will never affect the 
gamma component of the image.

NOTE. The device placement, and its proximity to other objects, will never affect 
the gamma component of the image. Only the stitching of the optical image will 
be affected.

WARNING. Incorrect lifting technique when handling the system can result in injury. To avoid this, ensure 
proper lifting technique is used at all times when lifting and carrying the system.

Set up the supplied tripod by undoing the clips at the base of the tripod and extending the legs out to the desired height. 
Ensure that the tripod is level, that the legs are locked in place once extended and that the tripod feet are flat on the ground 
prior to placing CORIS360® on the tripod.



13

2.5.  CORIS360® Connections

WARNING. Inserting the power supply into the device while powered can result in electric shock, sparking 
or a fire hazard. To avoid this, ensure the power supply is never powered when plugging into the system.

CAUTION. Operating the system using a power supply that does not input the correct voltage can damage 
the system. To avoid this, ensure only the power supply provided is used when operating the system.

Connect CORIS360® to mains power using the power cable provided. The mains power should have an input of 100 VAC – 240 
VAC (47 Hz – 63 Hz) and must be capable of providing 24 VDC and a minimum of 90 W to CORIS360®. Tighten the collar on the 
power cable plug to secure in place. If running off a battery, CORIS360® still requires the same input provided by the supplied 
power pack (24 VDC and a minimum of 90 W).
 
Connect CORIS360® to the computer either through the Ethernet cable or Wi-Fi dongle provided (Wi-Fi only available for 
firmware version 1.0.6 and above). 

To communicate with CORIS360® using the Ethernet cable, plug the cable into the Ethernet port on CORIS360® and the 
computer. If the computer being used does not have an Ethernet port, a USB to Ethernet adapter will be required. Once 
plugged in, CORIS360® will automatically connect to the computer, indicated by the CORIS360 Status in the bottom right corner 
of the software window reading “Connected”.

NOTE. For CORIS360® devices with firmware versions below 1.0.6, a static IP address will need to be setup to connect to 
CORIS360® instead of connecting automatically. This will need to be set up any time the user connects CORIS360® to a new 
computer. See Appendix A for steps on how to complete this setup.

NOTE. Once an image capture has begun, the Ethernet cable can be unplugged, or the Wi-Fi disconnected, from CORIS360® 
and the image capture will continue to run as normal. To stop the image capture or communicate with the device for any 
reason, the Ethernet cable must be plugged back in, or the Wi-Fi reconnected.

To communicate with CORIS360® using Wi-Fi, plug the Wi-Fi dongle into the USB port on CORIS360®. Connect to the Wi-
Fi from the computer using the Network icon in the Windows taskbar. The name of the network for your CORIS360® 
device is “CORIS360_<SERIAL NUMBER>”. For example, a device with serial number “001C10” will have a network name 
“CORIS360_001C10”. The serial number of your device can be found on the bottom of your CORIS360®. The default  Wi-Fi 
password for your CORIS360® device is “coris360”.

The software also provides the user with the ability to change the Wi-Fi password and to disable the Wi-Fi altogether (meaning 
no Wi-Fi signal will be emitted). To make these changes, open either the CORIS360® Radiation Imaging software or the 
CORIS360® Detector Calibrator tool and click Tools > Device Settings from the menu bar at the top of the window. See Section 
4.1 for further description on the Device Settings window.
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1.  Power Button

2.   Ethernet Port

3.  USB Port

4.  Power Cable Port

2.6. Changing the Detector 

Detector Colour Max Angular Resolution Dose Rate Range

CLLBC15
Cylindrical 1.5” CLLBC 
Scintillator with SiPM Array

Red 20° ± 1° <0.1 µSv/h – 2 mSv/h 
(<0.01 mrem/h – 200 mrem/h)

CLLBC05
Cylindrical 0.5” CLLBC
Scintillator with SiPM Array

Blue 15° ± 1° <0.1 µSv/h – 40 mSv/h 
(<0.01 mrem/h – 4000 mrem/h)

Two detectors are supplied with CORIS360®, the details of which are given in the table below.

Lastly, after all connections have been made, push the power button to turn the system on. The button will light up green, 
indicating the system is powered. To turn the system off, hold down the power button for 3 seconds.

A labelled photo of the CORIS360® connections is shown below:
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CAUTION. Inserting/removing the detector from the system while it is switched on can damage the 
detector. To avoid this, ensure the system is always switched off before inserting/removing the detector.

Each detector is encased in a cylindrical shell coloured according to detector size, as shown in the images below. The 1.5” 
CLLBC detector (CLLBC15) is red and the 0.5” CLLBC detector (CLLBC05) is blue. The detectors are equipped with in-built 
temperature compensation to ensure optimal performance throughout the entire operating temperature range (5 °C – 40 °C | 
41 °F – 104 °F). The red detector has a greater detection efficiency due to its larger volume and will result in significantly faster 
detection and imaging times. The CLLBC15 (red) detector should be used in most scenarios. The blue detector has a lower 
detection efficiency due to its smaller volume, however it has a better maximum angular resolution and larger dose rate range. 
This detector should be used in scenarios where higher angular resolution is required or in very high dose rate scenarios 
(> 2 mSv/h  |  > 200 mrem/h).

1. First, ensure the system is switched off before inserting or removing the detector.
2. Using the supplied M5 hex key, unscrew and remove the circular lid on top of the CORIS360® system.
3. If a detector is already in the system, gently pull the detector directly upwards to remove it.
4. Insert the new detector into the system, using the triangular arrow on top of the detector casing (shown in the  

image above) as a guide by pointing the arrow towards the front of the system.
5. When the detector and system are correctly aligned (a slight dip will be felt), push the detector gently, but firmly,  

into the connector. 
6. Check that the detector is properly attached by ensuring it cannot be easily lifted.
7. Re-attach and screw in the circular lid for CORIS360®.

To insert/remove a detector from the system:



CORIS360® Gamma Imaging System User Guide16

2.7.	 Software	Installation	and	Updates

Before the user can operate CORIS360®, they must first install the CORIS360® Radiation Imaging software. To install the 
software:

1. Using a computer with the specifications detailed in Section 2.2, download the software from the downloads page of the 
CORIS360® website (www.coris360.com).

2. Enter the user’s email address and the software downloads password provided to the user in their CORIS360® welcome 
email.

3. Download the CORIS360® software. This CORIS360® Download Centre also allows the user to download a digital version of 
this user guide, as well as providing some training videos to help the user get started with their device.

4. Run the downloaded software installer and follow the prompts to complete the installation. A desktop shortcut will be 
created during the installation process.

5. The CORIS360® Radiation Imaging software is now ready to run.

To uninstall the CORIS360® Radiation Imaging software:

1. Navigate to the directory where the software was installed
a. The default folder name is “CORIS360” and the default location is “C:\Program Files”.
b. The user can also navigate to the folder by right-clicking the CORIS360® Radiation Imaging software shortcut on the 

computer desktop and selecting “Open file location”.
2. Once in the folder, double click “maintenancetool.exe” and follow the prompts to complete the uninstallation.

The CORIS360® Radiation Imaging software automatically checks for software updates when there is an internet connection. 
This automatic check can be turned off in the Settings window if desired. The user can also manually check for updates 
whenever they like by clicking Help > Check For Updates from the menu bar at the top of the software window. When notified 
that there is a new software version available, it is recommended that the user follows the prompts and updates their software 
to the latest version. To update the software:

1. Follow the prompts to download the latest software version (*.exe file).
2. Run the downloaded installer and follow the prompts to complete the installation.
3. If desired, uninstall the old CORIS360® Radiation Imaging software using the instructions at the beginning of Section 2.7.

The firmware on CORIS360®, that is, the software on the CORIS360® device itself, will also periodically have updates available. 
When notified that there is a new software version available, it is again recommended that the user updates their software to 
the latest version. To update the firmware:

1. Follow the prompts to download the latest firmware version (*.iso file).
2. Open the CORIS360® Detector Calibrator tool and click File > Update CORIS360 Firmware… from the menu bar at the 

top of the window.
3. Open the downloaded *.iso file and follow the prompts to complete the firmware update.

https://www.ansto.gov.au/products/detection-and-imaging-coris360%C2%AE/coris360%C2%AE-software-downloads
https://www.coris360.com/
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3.   QUICK START GUIDE

3.1. Set Up and Use CORIS360®

The following steps help the user quickly power on, connect and use the CORIS360® system.

WARNING. Operating the system in wet conditions can result in electric shock. To avoid this, ensure the 
system is only operated in accordance with IP54 rating.

CAUTION. Operating the system outside of the operating temperature range can damage the system and 
decrease performance. To avoid this, ensure the system is only operated inside the operating temperature range.

1. If not done previously, install the CORIS360® Radiation Imaging software using the steps in Section 2.7.
2. Connect CORIS360® to mains power and to the computer using the provided cables and Wi-Fi dongle.
3. If not done previously, insert the CLLBC15 (red) detector into the system using the steps in Section 2.6.
4. Turn the system on by pushing the power button. The button will light up green.
5. Open the installed CORIS360® Radiation Imaging software using the shortcut on the computer desktop. 
6. Press the New Image    button.
7. In the New Image Capture window, select a Sample Time (5 s recommended) and enter an Image Capture Name for the 

current image, then press Start  .
8. CORIS360® will begin the image capture and start taking samples.
9. Only the optical image will be displayed initially, with the centre of the panorama representing the front of CORIS360®.
10. If a peak is identified through the software’s automatic radionuclide identification, the gamma image for that peak will be 

overlaid onto the optical image.
11. If no peak is automatically identified, a region of interest (ROI) must be added to produce the overlaid gamma image. To 

add an ROI:
a. Click the + Add ROI button in the bottom right of the software window. 
b. Enter a name for the ROI.
c. Set the energy range of the ROI either by selecting a peak from the pre-defined dropdown library or by entering the 

ROI values manually. The ROI can also be edited by moving the ROI in the spectrum tab on the left.
d. Click Add ROI and the reconstructed gamma image for the newly added ROI will be overlaid onto the optical image 

once it achieves an image quality above “Insufficient Data”.
12. To complete the image capture, press the Stop  button. The data will be saved automatically in the user’s home 

directory.
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3.2. CORIS360® Imaging Tips

The following list provides tips on how to use the CORIS360® system, along with recommended settings and equipment to use. 
This list has been collated from the tips and recommendations located throughout this manual. 

1. When setting up a new image capture, it is best practice that there are no objects within a 1 m radius of the device.
2. The CLLBC15 (red) detector is the recommended detector in most scenarios. This is due to the CLLBC15 detector having 

a greater detection efficiency, resulting in significantly faster detection and imaging times. The CLLBC05 (blue) detector 
should be used in higher dose rate (> 2 mSv/h  |  > 200 mrem/h) environments.

3. When selecting a sample time for a new image capture:
a. A sample time of 5 s is a suitable value for most gamma imaging scenarios where the dose rate at the detector is  

≥ 1 µSv/h (≥ 0.1 mrem/h). Use the help button in the New Image Capture window for guidance.
b. Ensure that for every region of interest (ROI) the user wants to analyse, the sample time is long enough such that 

the average number of ROI counts per sample is at least 100 counts. To check this value, click the Signal tab on the 
software’s main window.

4. Increasing the sample time and acquiring more samples will both result in a more accurate gamma image. However, it is 
generally more beneficial to increase the sample time rather than acquire more samples.

5. When determining the required number of samples for an image capture, more complex scenarios (i.e. the more hot spots 
present) will require more samples.

6. When adding ROI’s:
a. The software contains an automatic radionuclide identification feature. This feature automatically identifies peaks in 

the spectrum and adds them to the ROI table.
b. If custom ROI’s are added following the radionuclide identification, a practical first choice is to add ROI’s around any 

visible peaks in the spectrum that were not automatically identified.
c. Double-clicking the centre of any visible peaks (after clicking + Add ROI ) is the recommended method for adding a 

custom ROI as the software will automatically set an accurate width for the ROI.
d. When adding a custom ROI, the software may display a warning message at the bottom of the Regions of Interest tab. 

This message informs the user that their ROI selection is not good. If these warning messages are ignored and the ROI 
is still selected, the resulting gamma image will likely be inaccurate and unstable.

7. When determining if a reconstructed image is accurate and whether the image capture can be stopped:
a. The Image Quality column in the ROI table is the primary indicator of the accuracy and reliability of the gamma 

image.
b. When determining if the user should stop an image capture, it is recommended that more samples be acquired until 

the gamma image for the ROI achieves an image quality of at least “Good”.
8. When checking and re-calibrating the detector using the CORIS360® Detector Calibrator:

a. It is recommended that the calibration of the detectors is checked at least monthly.
b. Re-calibrating using the spectrum is the recommended method. This involves clicking on the centre of any visible 

peaks in the spectrum and assigning them an energy from the list of added sources.
c. At least four peaks need to be assigned an energy to obtain an accurate calibration fit.
d. Determining which peak is associated with which energy can be difficult when the calibration is wrong. A useful 

tool when assigning these peaks is to look at a spectrum of the source the user is calibrating with, labelled with the 
energies of its peaks. These gamma spectra are readily available online. A labelled 152Eu source is provided in  
Appendix D. 
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3.3.	 CORIS360®	Example	Files

Three example files are provided with the CORIS360® Radiation Imaging software to assist the user with becoming familiar 
with the software and its features, and to demonstrate just some of the capabilities of CORIS360®. To access the example files, 
click File > Open Example from the menu bar in the top left of the software window.

The first example is the Nuclear Security Example, which demonstrates the usefulness of CORIS360®’s wide optical and 
gamma field of view, allowing multiple cars to be searched at one time. The software automatically identifies the 137Cs in the 
spectrum, and then displays the resulting gamma image over the optical image. As the results show, multiple sources from the 
same radionuclide can be viewed on the same image overlay.

The second example is the Multiple Sources Example, which illustrates how CORIS360® can identify and image multiple 
sources in the one acquisition. By simply clicking through the automatically identified ROI’s in the Regions of Interest table, 
the user is able to see what region of the spectrum is currently being reconstructed over, and the corresponding gamma image 
in the radiation overlay above. This example also illustrates CORIS360®’s ability to identify and image radionuclides over a wide 
energy range (from 40 keV to >3 MeV), all from a single acquisition.

The third example is the X-Ray Example, which shows CORIS360®’s ability to image at the very low energy range (< 40 keV) and 
the ability to image non-peak regions of a spectrum. As there are no peaks in this example’s spectrum, no radionuclides will 
be automatically identified. Therefore, to view the gamma image, a custom ROI will need to be added by clicking + Add ROI  
from the Regions of Interest  tab at the bottom right of the software’s main screen (see Section 4.3 for detailed instructions on 
adding a custom ROI). If the user wants to add a ROI below 40 keV, they must first click the Settings  button and check the 
box to allow ROI’s below 40 keV. Note that the user should only check this box when performing an image capture if they are 
confident that they know what they are doing. Once the user adds a custom ROI, the gamma image will be displayed over the 
optical image.

3.3. CORIS360® Training Videos

Training videos are provided with CORIS360® to help the user get started with their device. These videos can be accessed from 
the CORIS360® Download Centre, the same location where the software is downloaded from. To access this download centre:

1. Navigate to the downloads page of the CORIS360® website (www.coris360.com).
2. Enter the user’s email address and the software downloads password provided to the user in their CORIS360® welcome 

email.
3. The training videos can then be accessed from the CORIS360® Download Centre.

https://www.ansto.gov.au/products/detection-and-imaging-coris360%C2%AE/coris360%C2%AE-software-downloads
https://www.coris360.com/
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4.  USING THE CORIS360® RADIATION IMAGING SOFTWARE

4.1.	 Software	Features	Explained

1.  Start new image capture

2.   Open previously saved image 
capture stored on computer 

3.   Download previously saved image 
capture stored on CORIS360® device

4.   View currently acquiring image 
capture after software was closed 
and re-opened

1 2 3 4

Home	Window
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New	Image	Capture	Window

1.    Length of time data will be acquired 
for each individual sample

2.  Name of current image capture

3.   Location where image capture is 
occurring (optional)

4.   Name of operator performing the 
image capture (optional)

5.   Help button to assist with selecting 
correct sample time

6.   Advanced options to enable/disable 
optical panorama and schedule 
image capture

7.  Brief description of current image   
  capture scenario (optional)

8.  Close New Image Capture window

9.  Start the image capture

1 5

87 9

432

6
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1.  Toolbar buttons

2.  Radiation image overlay buttons

3.  Summarised image capture information

4.  Settings button

5.  Change between spectrum/signal tabs

1 2 3 4

Main	Window	(With	Spectrum	and	Regions	of	Interest	Tab)

6 8 9 105 7

6.  Spectrum buttons

7.  Gamma/Optical image overlay

8.  Spectrum (displaying counts per gamma-ray energy)

9.  Regions of Interest table

10.  CORIS360 Status



Main	Window	(With	Signal	and	Combined	Region	of	Interest	Tab)

21 3

23

1.  Change between spectrum/signal tabs

2.  Signal (displaying counts per sample number)

3.  Combined Region of Interest table
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Settings	Window

1.    Enable/Disable display settings to 
optimise dots per inch (DPI) scaling 
or for tablet device

2.    Enable/Disable automatic check for 
software updates

3.   Default location where data is 
automatically saved at end of image 
capture

4.    Changes the interpolation scale of 
the reconstructed radiation image

5.   Enables/Disables ability to view 
radiation image even when image 
quality is bad

6.  Enables/Disables ability to create   
  ROI’s below 40 keV

7.  Enables/Disables outdated detector  
  calibration warning

8.  Change, manage and customise  
  active  library for radionuclide  
  identification

2

8

43

6

1

5 7
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Device	Settings	Window

1.  Enables/Disables Wi-Fi. If disabled, 
  no Wi-Fi signal can be emitted

2.  Changes the password to connect to 
  the Wi-Fi

3.  Enables/Disables the optical  
  cameras. If disabled, it is not  
  possible to take an optical image

4.  Sets CORIS360®’s time to match the 
  users current local time (according 
  to the time set on the connected 
  computer)

5.   Changes the password back to the 
factory default password (“coris360”)

1 2

3 54
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Toolbar	Buttons	Explained

Radiation	Image	Overlay	Buttons	Explained

Spectrum	Buttons	Explained

Open home window

Start new image capture

Load previously saved image capture stored on computer

Display detailed information on current image capture

Toggle optical image between colour and greyscale to improve gamma image clarity

Toggle gamma image pixel interpolation on/off

Reset the zoom of the panorama to full-scale (mouse scroll wheel can zoom in/out)

Set the distance from CORIS360® to the suspected radiation source. As the radiation detector and optical cameras are 
not at the same location in space, some optical/radiation image parallax error is unavoidable. This can be compensated 
for by inputting the approximate distance to the suspected radiation source. In practice, parallax effects are negligible 
except at distances less than ~1–2 m. As such, setting the distance correctly is more critical for close-up imaging

Adjust the brightness and contrast of the optical panorama, or replace it with another panorama. Any optical panorama 
changes that are made can be reverted back to the original panorama that was taken during the initial image capture.

Set cursor mode on spectrum tab. In cursor mode the user can:
• Click and drag right to zoom in
• Click and drag left to reset zoom
• Right-click to add an ROI at the cursor position
In cursor mode and while adding an ROI the user can:
• Double click to set ROI centroid
• Click and drag ROI marker lines

Set zoom mode on spectrum tab. In zoom mode, clicking on the spectrum will zoom in on the cursor location

Reset the zoom of the spectrum to full-scale (mouse scroll wheel can also zoom in/out)

Toggle the spectrum y-axis between logarithmic and linear scale
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4.2. Start an Image Capture

To start a new image capture, follow the steps below:

WARNING. Operating the system in wet conditions can result in electric shock. To avoid this, ensure the 
system is only operated in accordance with IP54 rating.

CAUTION. Operating the system outside of the operating temperature range can damage the system and 
decrease performance. To avoid this, ensure the system is only operated inside the operating temperature range.

1. If not previously installed, install the CORIS360® Radiation Imaging software using the steps in Section 2.7. 
2. Connect CORIS360® to mains power and the computer using the provided cables and Wi-Fi dongle.
3. If not done previously, insert one of the provided detectors into the system using the steps in Section 2.6. 
 

NOTE. The CLLBC15 (red) detector is recommended in most 
scenarios due to its greater detection efficiency, resulting 
in significantly faster detection and imaging times. The 
CLLBC05 (blue) detector should be used in higher dose rate 
(> 2 mSv/h  |  > 200 mrem/h) environments.

4. Open the installed software. A shortcut will be present on 
the computer desktop after the installation.

5. Turn the system on by pushing the power button. The 
button will light up green.
a. The system will then initialise for < 1 min. 

Initialisation is complete when the CORIS360 Status 
in the bottom right corner of the software window 
reads “Connected”.

6. Press the New Image    button, opening the  
New Image Capture window (shown on the right).
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7. In the New Image Capture window, a Sample Time must be selected and an Image Capture Name must be entered, with 
the rest of the fields optional.
a. The Sample Time is the length of time (in seconds) that data will be acquired for each individual sample (the time in 

each mask position). A sample time of 5 s is a suitable value for most gamma imaging scenarios. For low dose 
environments, however, this value should be increased. The two tables below provide a rough guide for the sample 
times required for various gamma dose rates for both the CLLBC05 and CLLBC15 detectors, respectively. See  
Section 5.1 for further information on selecting the optimal sample time.

NOTE. Longer sample times will always produce better results, but the image acquisition will take longer.

NOTE. The sample time is NOT the total image capture time, but rather the time for each individual sample (the time in 
each mask position). The total image capture time is (sample time) × (no. samples).

b.  The Image Capture Name is the name the user gives to the current image capture and will be the name used when 
saving the results. 

c. The Location, Operator and Description fields are all optional and can be used to include more descriptive 
information about the current image capture.

d. The 360° panoramic image  check box sets whether the user wants to take an optical image as well as a gamma 
image (checked), or just the gamma image (unchecked). 

e. The Schedule check boxes allow the user to delay the start time of the image capture or set the image capture to 
finish at a certain time.

f. It is highly recommended that the user reads Section 5.1 of this manual which provides detailed instructions and tips 
on selecting the optimal Sample Time and how many samples to acquire.

NOTE. The Image Capture Name, Location, Operator and Description fields can be edited after a measurement is 
completed by clicking the        button at the top of the software window, then clicking the button Edit.

8. After all necessary fields are completed, press the Start    button. 
9. CORIS360® will begin the image capture and start taking samples.

a. If the Schedule check box was checked to delay the start of the image capture, a countdown timer window will appear 
(shown on the next page) displaying the time remaining before the image capture starts.

Dose Rate  
(µSv/h)

Dose Rate 
(mrem/h)

CLLBC05 Detector (blue)
Sample Time (s)

CLLBC15 Detector (red) 
Sample Time (s)

< 0.5 < 0.05 120+ 30 – 60+ 

0.5 – 1 0.05 – 0.1 60 – 120 10 – 30

1 – 2 0.1 – 0.2 20 – 60 5 – 10 

2 – 5 0.2 – 0.5 10 – 20 3 – 5

5 – 10 0.5 – 1 5 – 10 2 – 3

> 10 > 1 2 – 5 1 – 2
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10. Once the image capture has started, counts will begin accruing in the Spectrum tab at the bottom of the software window.
a. The four optical cameras will take photos of the scene and create a 360° panorama (if the 360° panoramic image box 

was checked). During this time, it is best practice to ensure nothing is moving in the field of view of CORIS360® to avoid 
any image artefacts. The optical image will then be displayed once the individual images have been stitched together 
to create the panorama. The centre of the panorama represents the front of CORIS360®.

b. The device will continue acquiring data until either the Stop    button is pressed, the image capture was scheduled 
to end at a certain time or CORIS360® has acquired 1024 samples.

NOTE. The optical panorama can be retaken at any point while the image capture is still acquiring data by clicking  
Tools > Retake Optical Images  from the menu bar at the top of the main window.

11. Only the optical image will be displayed initially.
12. If a peak is identified through the software’s automatic radionuclide identification, the gamma image for that peak will be 

overlaid onto the optical image once it achieves an image quality above “Insufficient Data”.

NOTE. The software also has an in-built neutron detection alarm due to the detectors having a dual gamma and thermal 
neutron response. When neutrons are detected, a window will appear notifying the user.

13. If no peak is automatically identified, a region of interest (ROI) must be added to produce the overlaid gamma image. To 
add a custom ROI, follow the steps in Section 4.3.

14. To complete the image capture, press the Stop    button or wait for CORIS360® to acquire all 1024 samples. The data will 
be saved automatically on the computer in the user’s home directory as a .c360 file (the automatic save location can be 
changed through the Settings    button on the main window).
a. The automatically saved .c360 file will have a filename consisting of the image capture name, the file ID number and 

the serial number of the CORIS360® device.
b. To save the data to a different location, click File > Save As… from the menu bar in the top left of the window and 

follow the prompts. 
c. Saved data can be loaded back into the software at a later date for further analysis and to generate a report of the 

results. 
15. After the image capture is complete, the masks will rotate back to their home position, ready for the next capture.

NOTE. When an image capture has completed, the data is also automatically saved on CORIS360® itself. This allows for the 
data to be viewed on any computer by downloading the data from CORIS360®.
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4.3.	 Adding	a	Region	of	Interest	(ROI)

The CORIS360® Radiation Imaging software contains an automatic radionuclide identification feature. This feature identifies 
peaks in the spectrum and automatically adds them to the Regions of Interest (ROI) table, along with their corresponding name 
and energy. The fully customisable radionuclide library contains 15 common radioisotopes by default (see Section 4.8 for steps 
on how to customise the library). When a peak is automatically identified, it will have type “ ID ” in the ROI table. ROI’s of type  
“ ID ” cannot be edited or deleted.

Following the automatic radionuclide identification, the user may want to add a custom ROI. Reasons for adding a custom 
ROI could include adding a peak in the spectrum which was not automatically identified or wanting to image over a non-peak 
region in the spectrum (see Section 3.3 and the X-Ray Example). To add a custom ROI, follow the steps below.

NOTE. All ROI’s are saved when an image capture is saved. These ROI’s will then be loaded back into the ROI table when  
re-opening an image capture. This allows for any previous data analysis to be saved, stored and re-opened for future use.

1. From the main window in the software, ensure you have selected the Regions of Interest tab and click the + Add ROI 
button in the Regions of Interest tab at the bottom right of the screen, displaying the tab shown below.
a. The user can also add an ROI by right-clicking on the spectrum and selecting Add ROI.

2. Enter a name for the ROI or use the default name provided.
3. The ROI can then be set using any of the following methods:

a. Select a pre-defined peak from the dropdown library.
b. Enter either a minimum and maximum energy range for the ROI or enter the centroid energy for the ROI.
c. Using the spectrum on the left, double-click the spectrum to centre the ROI at a specific energy. This will also 

automatically set the width of the ROI.
d. Using the spectrum, click on each of the red ROI marker lines and drag them to the desired minimum and maximum 

energies. 

NOTE. The ROI help button    can also be used to provide further information on how to add a ROI.
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4. Once the ROI has been set, click Add ROI and the reconstructed gamma image for the selected ROI will be overlaid onto 
the optical image once it achieves an image quality above “Insufficient Data”.

5. Multiple ROI’s can be added by repeating Steps 1 – 4. The gamma image being overlaid on the optical image can be 
alternated by selecting different ROI’s in the table.

6. ROI’s added using the above method are manually entered ROI’s and have type “User”. 
a. Only “User” ROI’s can be edited or deleted. To edit or delete a “User” ROI, press the Edit   button.

7. The final column in the ROI table, titled Image Quality, indicates the quality of the reconstructed image for the selected 
ROI. This column is the primary indicator of the accuracy and reliability of the gamma image. For a description of each 
Image Quality level and a deeper explanation of how to interpret the image quality, see Section 5.1.

CORIS360® has the ability to image over both peak and non-peak energy ranges in the spectrum. If custom ROI’s are added 
following the radionuclide identification, a practical first choice is to add a ROI around any visible peaks in the 
spectrum that were not automatically identified. Double-clicking the centre of any visible peaks is the recommended 
method for adding a custom ROI as the software will automatically set an accurate width for the ROI. 

If no peak is visible, but a significant number of counts are present in the spectrum, it is possible a gamma emitting 
radionuclide may be present behind some form of shielding. This shielding could either be environmental (i.e. through a 
building wall) or through intentional masking. In this case, it is sensible to set the ROI to a wide range of the spectrum (e.g. 100 – 
200 keV) to create a gamma image using scattered radiation.

For further instructions on how to select a practical ROI, see Section 5.2.
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4.4.	 Adding	a	Combined	Region	of	Interest	(CROI)

Once ROI’s have been added to the ROI table, the CORIS360® Radiation Imaging software provides the ability to show multiple 
ROI’s on the same radiation image overlay using the Combined Region of Interest (CROI) tab. This can be a visually effective 
way of displaying multiple radiation sources and their corresponding locations all on the one optical panorama, as can be seen 
in the image below.

The CROI table contains a list of the ROI’s that have already been added, with both automatically identified and custom ROI’s 
being included. By toggling the Display check boxes in the CROI table, the user can display any combination of ROI’s at the 
same time.

NOTE. A maximum of 7 ROI’s can be displayed at any one time in the CROI tab.
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4.5.	 Open,	Download	or	View	Current	Image	Capture

The Open Image    button is used to load a previously saved image capture stored on the computer. To use this button, follow 
the steps below:

1. If not done previously, open the CORIS360® Radiation Imaging software.
2. Click the Open Image    button either from the home window, from the top left corner of the main window or by using 

the shortcut Ctrl+O.
3. Navigate to the desired image capture and select Open. 
4. The previously saved image capture will then be loaded from the computer and ready for analysis or data exportation.

The Download from CORIS360  button is used to load a previously saved image capture stored on the CORIS360® device itself. 
Once an image capture is completed, the data will be automatically saved to both CORIS360® and to the computer CORIS360® 
is connected to. This button would be used in scenarios where, for example, a new computer is being used with CORIS360® and 
the user wants to look at a previous image capture obtained on the device. By clicking the Download from CORIS360  button, 
this previous capture can be loaded from CORIS360® and viewed on the connected computer. To use this button, follow the 
steps below:

1. If not done previously, open the CORIS360® Radiation Imaging software and connect the computer to CORIS360® using 
the provided Ethernet cable or Wi-Fi dongle.

2.  Click the Download from CORIS360  button from the home window, opening the Download Image Data from CORIS360 
window.

3.  Using this window, select the image data to be loaded and click Download. The user is also able to delete any image data 
stored on CORIS360® when in this window.

4. The saved image capture will then be loaded onto the connected computer ready for analysis or data exportation. The 
image capture can also now be saved directly to the computer.

While the Unique Colours check box is checked, each checked ROI will have a unique colour assigned to it, with this colour also 
being used to mark the corresponding radiation image hot spot and ROI in the spectrum. When the Unique Colours check box 
is unchecked, the radiation image hot spot for each ROI will no longer have a unique colour but will instead all use the software 
default colour map.

If the Normalise each ROI check box is checked, the radiation image hot spot for each ROI will first be scaled by its maximum 
count rate, and then combined. Despite potentially large count rate differences between the individual ROI’s, the radiation 
image hot spot for each ROI will display with the same visual intensity. This is useful for determining the location of multiple 
radioactive sources, where the intensity of each source is not important. If this check box is not checked, the radiation image 
hot spot for each ROI will be scaled by the maximum count rate of all the ROI’s (detector efficiency not taken into account). This 
method of displaying the data provides a more accurate interpretation of the relative count rate intensities between each of the 
ROI’s.
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4.6.	 Using	the	Spectrum	and	Signal	Tabs

Using the CORIS360® Radiation Imaging software, the user has the ability to obtain much more information on the image 
capture results through the Spectrum and Signal tabs on the main window. The Spectrum tab is shown initially by default. 
From this tab the user is able to view and manipulate the spectrum using either the cursor or the spectrum buttons. For 
detailed information on the function of the Spectrum buttons and how to manipulate the spectrum, see Section 4.1. Selecting 
a different ROI from the ROI table will display the location of the selected ROI on the spectrum. In addition, placing the cursor 
in the spectrum plot will inform the user of the energy and number of counts at that energy for the current cursor position. The 
tab also provides a variety of spectrum information regarding the current image capture. An explanation of this information is 
provided below:

Live Time (s) Refers to the total time the detector was recording counts. This differs to the 
elapsed time, which is the total time the image capture has been acquiring for.  
The live time can differ due to an intrinsic property of detectors which require a 
fraction of a second to recover after a photon of radiation hits the detector. This 
difference between live time and elapsed time can differ significantly for a large 
amount of incident photons (large dead time).

Count Rate (s-1) The number of photons being counted by the detector per second.

Dead Time (%) Represents the percentage of time that the detector was “dead”  
(i.e. not recording counts).

ROI Rate (s-1) The count rate for only the region of the spectrum within the selected ROI.

The View Current Image Capture  button is used to view an image capture that is currently acquiring data on CORIS360®. 
This button would be used in scenarios where, for example, the user opens a previous image capture or the software is closed 
then re-opened, both while the device is still acquiring. In both examples, the device will continue acquiring data as normal, 
and the user can return to this capture by clicking the View Current Image Capture  button. To use this button, follow the 
steps below:

1. If not done previously, open the CORIS360® Radiation Imaging software and connect the computer to CORIS360® using 
the provided Ethernet cable or Wi-Fi dongle.

2.  Click the View Current Image Capture  button from the home window, or in the top right corner of the main software 
window.

3. The image capture currently acquiring data on CORIS360® will then be shown on the software’s main window and will 
continue acquiring as normal.

NOTE. Once an image capture has begun, the Ethernet cable can be unplugged, or the Wi-Fi disconnected, from CORIS360® 
and the image capture will continue to run as normal. To stop the image capture or communicate with the device for any 
reason, the Ethernet cable must be plugged back in, or the Wi-Fi reconnected.
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Use all samples Calculates the gamma image using all completed samples.

Custom range Calculates the gamma image using a custom range of completed samples.

Always use latest Check box which calculates the gamma image using a custom range of completed 
samples, and when checked, adds the latest completed sample to the end of the 
custom range used for the calculation. This check box is useful when an image 
capture is still acquiring data.

By clicking the Signal tab, the user is provided with information regarding the number of counts CORIS360® is acquiring per 
individual sample. This tab therefore allows the user to determine whether they are acquiring enough counts per sample to 
produce an accurate gamma image. It is recommended that the user reads Section 5.1 for a more detailed understanding of 
the required number of counts per sample. Changing the selected ROI from the ROI table changes the plot in the Signal tab, 
allowing the user to check that they are acquiring enough counts for all ROI’s. In addition, placing the cursor in the signal plot 
will inform the user of the sample number of counts in that sample and the sample start time for the current cursor position. 
The tab also provides various processing options, providing the user with the ability to change the sample range that is 
currently being used to calculate the gamma image. This feature is useful in scenarios where, for example, the gamma source 
of interest was moved or altered during an image capture. By using the custom sample range feature, the user is able to exclude 
samples consisting of bad data from the beginning or end of a capture instead of having to discard and repeat the entire image 
capture. Utilising this custom sample range feature also allows the user to perform time lapsed imagery, providing the ability to 
view the movement of a source by imaging over different sample ranges. An explanation of the processing options is provided 
below:
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4.7.	 Generating	a	Report,	Exporting	Data	and	Reporting	a	Problem

Once an image capture has completed, the CORIS360® Radiation Imaging software provides the ability to export the results 
from the image capture into a zip file containing the data for external analysis. A description of each file contained in the 
exported zip file is given below:

4 Raw Optical Images The raw, unstitched optical images from the 4 cameras in CORIS360®.

Optical Panorama The optical panorama made from the 4 raw optical images stitched together.  
The gamma image is overlaid on top of this stitched photo in the software.

Export Information  
.txt file

A text file containing all of the essential image capture information such as 
the capture name, sample time and number of samples, detector calibration 
parameters and the start and end time of the capture.

Export Sample Timing 
.csv file 

A csv file containing live time, real time and dead time information for each 
individual sample.

Export Spectra  
.csv file

A csv file containing the number of counts in each energy bin of the spectrum 
for each individual sample. Each row in this file is an individual sample and each 
column is the number of counts in that energy bin.

Export Spectrum 
.csv file

A csv file containing the total spectrum for the entire image capture. This file 
is equivalent to the Export Spectra file if the counts in each energy bin were 
summed together for all samples. The first column in the file is the energy (in keV) 
and the second column is the number of counts at that energy.

Export Spectrum 
.n42 file

A n42 file containing the same information as the csv file of the same name, 
however the data is in a format that can be readily accessed in spectroscopy 
analysis software.

Export ROI Data 
.csv file

A csv file containing the data for the reconstructed gamma image for the given ROI. 
One of these files will be exported for every ROI present in the ROI table.

Export ROI Image 
.png file

A png file containing the reconstructed gamma image overlaid on the optical 
image for the given ROI. One of these files will be exported for every ROI present  
in the ROI table.



37

To export the data, click File > Export Data from the menu bar in the top left of the software window (or use the shortcut Ctrl+E ) 
and follow the prompts to save the data in the desired location.

The software also has the capability to output a summary of the results in the form of a report. The report contains all of the 
essential information from the image capture, including the capture name, elapsed time, sample time and number of samples, 
spectrum, image overlay and all of the ROI’s in the ROI table. The user also has the ability to include any combined ROI’s in the 
report, along with the option to exclude certain ROI’s from the report using the advanced options. The first page of the report 
contains a summary of the image capture, with the remaining pages providing more detailed results on each of the ROI’s. An 
example report is provided in Appendix C.

To generate a report, click File > Generate Report from the menu bar in the top left of the window and follow the prompts to 
customise and save the report in the desired location. 

Lastly, the software also provides the ability to report a problem in the software in the unlikely event that one is encountered. To 
report a problem, click Help > Report a Problem from the menu bar in the top left of the software window. This will open a new 
email in the user’s default mail application, addressed to support@coris360.com. Please provide as much information in the email 
as possible when reporting a problem so that we can rectify the issue as soon as possible.

4.8.	 Changing	and	Customising	the	Radionuclide	Identification	Library

The software provides the user with the ability to change and create custom radionuclide libraries. These libraries are used 
by the automatic radionuclide identification feature of the software when fitting and assigning peaks in the spectrum. If a 
radioisotope is not contained in the active radionuclide library, it will not be assigned to any peak in the spectrum and will 
therefore not be identified.

The default radionuclide library contains 15 radioisotopes, which are listed in the table below. The default library cannot be 
edited or deleted.

40K 99mTc 137Cs 226Ra 238U
60Co 131I 192Ir 232Th 239Pu
67Ga 133Ba 201Tl 235U 241Am

To edit, create and change radionuclide libraries:

1. If not done previously, open the CORIS360® Radiation Imaging software.
2. From the main window, click the Settings  button to open Settings window (shown on the next page).
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3. Next, click the Manage Libraries… button, opening the Radionuclide Libraries window (shown below).

4. From this window, the user is able to create a new library, import or export a library and edit an existing library.

NOTE. The default library cannot be edited or deleted. A new library must first be created before radionuclides can be 
added or modified.

5. After a custom radionuclide library has been created, click the Apply then Save buttons and close the  
Radionuclide Libraries window.

6. Then, to update the radionuclide library actually being used by the software, in the Settings window change the  
Active library to the desired library. 

7. Lastly, click the Apply button, and the library being used by the software has now been updated.
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5.  UNDERSTANDING THE RESULTS

5.1.	 Image	Quality	Interpretation	and	Optimal	Image	Capture	Parameters

As a general rule, the longer the sample time and the larger the number of samples, the better the quality of the data. However, 
having these values too large will result in an unnecessarily long image capture, and will negate one of the primary advantages 
of CORIS360®, its rapid identification and imaging speed. Therefore, a balance of time and quality of data must occur when 
selecting the optimal image capture parameters.

Selecting the correct sample time is essential for the optimal operation of CORIS360®. The choice of sample time is highly 
dependent on the total number of counts per sample for the ROI/s that the user wants to analyse. Lower dose/count rate 
environments will require longer sample times while higher dose/count rate environments will require shorter sample times. 
It is best practice to ensure that for every ROI the user wants to analyse, the sample time is long enough such that the 
average number of counts per sample is at least 100 counts. This value can be easily determined by selecting the Signal tab 
at the bottom of the main window in the CORIS360® Radiation Imaging software (see Section 4.6 for more information on the 
Signal tab). The two tables from Section 4.2 have been repeated below to provide a rough guide for the sample times required 
for various gamma dose rates for both the CLLBC05 (blue) and CLLBC15 (red) detectors.

Once an acceptable sample time has been chosen, the next step is to stop the image capture once the correct number of 
samples have been completed. The number of samples required is primarily dependent on the complexity of the scenario 
being imaged, meaning the number of hot spots present in the image. For more complex scenarios, more samples will 
be required. A point source (one hot spot), for example, may require only 30 samples to be accurately imaged. A more 
complicated scenario (such as an extended source or many hot spots) would require further samples. The maximum number of 
samples CORIS360® will perform is 1024, however the user will almost never need to complete this full set of samples. 

To provide feedback to the user on when enough samples have completed, information on the image quality is provided in the 
ROI table for each ROI. The Image Quality column in the ROI table is the primary indicator of the accuracy and reliability 
of the gamma image. A description of each Image Quality level is provided on the next page.

Dose Rate  
(µSv/h)

Dose Rate 
(mrem/h)

CLLBC05 Detector (blue)
Sample Time (s)

CLLBC15 Detector (red) 
Sample Time (s)

< 0.5 < 0.05 120+ 30 – 60+ 

0.5 – 1 0.05 – 0.1 60 – 120 10 – 30

1 – 2 0.1 – 0.2 20 – 60 5 – 10 

2 – 5 0.2 – 0.5 10 – 20 3 – 5

5 – 10 0.5 – 1 5 – 10 2 – 3

> 10 > 1 2 – 5 1 – 2
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NOTE. It is recommended that more samples be acquired until the gamma image for a ROI achieves an image quality of at 
least “Good”.

In low gamma dose/count rate environments, scenarios can exist where, for a given sample time, no number of further samples 
will produce an accurate gamma image. In cases such as this, the two best options are to either increase the sample time or 
move closer to the suspected location of the source, then start a new image capture. A good indication that this scenario is 
occurring is when the ROI the user wants to analyse has fewer than 100 counts per sample on average.

It should be noted that for these low dose/count rate environments, it may be necessary to acquire data for a very long time, 
ranging from several hours to days. When trying to obtain a more accurate gamma image, it is generally more beneficial to 
increase the sample time rather than acquire more samples. This is especially true in scenarios with few hot spots.

… Indicates that the quality of the gamma image is still being processed.

Insufficient Data Indicates that the gamma image is not accurate, and more samples are required.

Low Indicates that the gamma image is nearing an accurate image, but more samples 
are recommended.

Good Indicates that the gamma image is likely an accurate image and more samples will 
improve the accuracy.

Excellent Indicates that the gamma image is highly likely an accurate image and more 
samples will continue to confirm the accuracy.
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5.2.	 Selecting	a	Practical	ROI

As detailed in Section 4.3, CORIS360® has the ability to image over both peak and non-peak energy ranges in the spectrum (see 
Section 3.3 for a demonstration of this capability). If custom ROI’s are added following the radionuclide identification, a 
practical first choice is to add a ROI around any visible peaks in the spectrum that were not automatically identified. 
Double-clicking the centre of any visible peaks is the recommended method for adding a ROI in this scenario since the 
software will automatically set an accurate width for the ROI. 

If no peak is visible, but a significant number of counts are present in the spectrum, it is possible a gamma emitting 
radionuclide may be present behind some form of shielding. This shielding could either be environmental (i.e. through a 
building wall) or through intentional masking. In this case, it is sensible to set the ROI to a wide range of the spectrum (e.g. 100 – 
200 keV) to create a gamma image using scattered radiation.

When adding a custom ROI, the software may display a warning message at the bottom of the Regions of Interest tab. This 
message informs the user that their ROI selection is not good. Examples of poor ROI selections include:

• A ROI with no peaks (unless attempting to image scattered radiation)
• A ROI with low or zero counts (a warning will display if a region with very low counts is selected)
• Background or continuum energy ranges (i.e. the energy range between peaks in the spectrum)
•  40K (Potassium-40), a common radionuclide present in the background in almost all locations. 40K exhibits a peak at  

1460 keV; this peak should not be used for imaging in most situations
•  232Th (Thorium-232), a common radionuclide present in the background in almost all locations. 232Th exhibits a distinct  

peak at 2614 keV; this peak should not be used for imaging unless the user is very confident that 232Th is present

NOTE. If ROI warning messages are ignored and the ROI is still selected, the resulting gamma image will likely be 
inaccurate and unstable.
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The two detectors supplied with the system come pre-calibrated, with the calibration information stored on the detector. 
An unavoidable feature of gamma-ray detectors is that over time their calibration will slowly drift, requiring re-calibration. 
The detectors can be re-calibrated using the CORIS360® Detector Calibrator tool. This tool can be accessed through the 
CORIS360® Radiation Imaging software by clicking Tools > Open CORIS360 Detector Calibrator from the menu bar at the 
top of the software window. Alternatively, a shortcut to the tool was also created on the computer desktop during the initial 
CORIS360® software installation. The steps required to perform this calibration and the features of the calibration tool are 
detailed on the following pages.

NOTE. It is recommended that the calibration of the detectors is checked at least monthly. The CORIS360® Radiation 
Imaging software will remind the user when it has been a month since the last calibration.

6.  RE-CALIBRATING THE DETECTOR
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6.1.	 CORIS360®	Detector	Calibrator	Features	Explained

1 2 3 4

Main	Window

7 8 9 12 13 145 6 10 11

1. Toolbar buttons 8. Displays all main peak energies for selected source

2. Spectrum buttons 9. Adds selected source in drop-down list (left button) 
or adds a blank row (right) to the calibration table

3. Spectrum (displaying counts per gamma-ray energy) 10. Energy calibration table

4. Settings button 11. Displays all energies in the calibration table on the 
above spectrum

5. Deletes selected row(s) from calibration table 12. Calibration curve (displaying energy against channel)

6. Deletes all rows from calibration table 13. Date of last calibration and CORIS360 status

7. List of possible sources to add for energy calibration 14. Copies the calibration curve fit parameters (a, b, c) to 
the clipboard
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New	Calibration	Window

1.   Name of operator performing 
calibration (optional)

2.   Opens calibration source selection 
window to add/edit the sources in 
the table below

3.   Removes selected source from  
table below

4.   Starts the new calibration

5.   Table of sources to be used for 
the calibration

6.  Closes the new calibration window

1

4 65

32
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Edit	Detector	Calibration	Window

1.  Name of detector

2.  Energy calibration factors (a, b, c)

3.  Saves current values to the detector

4.   Restores all values in the window 
with the values currently saved on 
the detector

5.   Closes the edit detector 
calibration window 

1 2

3 4 5
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Spectrum	Buttons	Explained

Set cursor mode on spectrum tab. In cursor mode the user can:
• Click and drag right to zoom in
• Click and drag left to reset zoom
• Click on the spectrum to assign spectrum peak to a source energy

Set zoom mode on spectrum tab. In zoom mode, clicking on the spectrum will zoom in on the cursor location.

Reset the zoom of the spectrum to full-scale (mouse scroll when can zoom in/out).

Toggle the spectrum y-axis between logarithmic and linear scale.

Toolbar	Buttons	Explained

Open new calibration window to start new calibration.

Stop currently acquiring calibration.

Restart currently acquiring calibration.

Save newly obtained calibration factors to detector.

Open edit detector calibration window to directly edit the energy and FWHM calibration factors on the detector.
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6.2.	 Checking	and	Re-Calibrating	the	Detector	

The CORIS360® Detector Calibration tool has two primary functions: checking that the current detector calibration is correct, 
and if not, re-calibrating the detector. When checking and re-calibrating the detector, it is advised that the provided calibration 
puck (containing an exempt 152Eu source) is used. 

The following steps detail how to check the detector calibration using the provided 152Eu puck. The 152Eu puck is the 
recommended source due to its emission of gamma ray peaks over a wide energy range, allowing for an accurate calibration. It 
should be noted, however, that while the 152Eu puck is the recommended source, any source can be used by following the same 
steps.

1. Using the supplied M5 hex key, unscrew and remove the circular lid on top of the CORIS360® system.
2. Place the 152Eu puck directly on top of the detector inside the system. The puck should fit snugly around the detector 

casing.
3. Press the Start   button in the toolbar menu at the top left of the screen, opening the New Calibration window.
4. In the New Calibration window, enter an operator name or use the default name provided.
5. If required, modify which source or sources the user will use to check the detector calibration using the  

Add From Library…  button. The 152Eu source is added by default as this is the recommended source to use.
a. Whatever sources are contained in the table will be the sources used for the calibration. Therefore, if the user is only 

using the 152Eu puck, only “Eu-152” should be present in the table.
6. After all sources have been added, press Start to begin acquiring the spectrum.
7. If the calibration is good, the automatic radionuclide identification will assign the peaks observed in the spectrum with the 

energies from the source/s the user added in Step 5.
a. Once a peak has been identified and assigned with an isotope energy, a blue vertical line is placed on the identified 

peak location. The corresponding table entry in the Energy Calibration tab also changes the peak row colour from 
orange to blue.

b.  Entries in the table of the Energy Calibration tab remain orange until they have been assigned with a peak in the 
spectrum, subsequently turning blue.

8. If all peaks from the added source/s are automatically identified, a message box will appear informing the user that the 
calibration check was successful and will ask if the user wants to stop and save the updated calibration.
a.  If, after 3 minutes, at least 75% of the peaks from the added source/s have been identified, a message box will again 

appear informing the user that the calibration check was successful and will ask if the user wants to stop and save the 
updated calibration.

b.  If, after 3 minutes, at least 75% of the peaks have not been identified, a message box will appear informing the user 
that the calibration check was unsuccessful and recommending what next steps the user should take.

9.  If the calibration check is determined to be successful, then the updated calibration should be saved and the detector can 
continue to be used as normal. If less than 75% of the peaks from the added source/s were identified, the calibration check 
is determined to be unsuccessful and the detector requires re-calibration.

NOTE. A useful method for confirming if a calibration is good or bad is to check the Graph all energies box in the Energy 
Calibration tab which will display on the spectrum the location of all energies currently added to the calibration table.
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If the detector requires re-calibration, perform the following steps:

1. If not done previously, complete Steps 1 – 6 above in the method for checking the detector calibration.
2. Since the detector requires re-calibration, it is likely that few or no peaks will be automatically identified. Re-calibration of 

the detector therefore involves manually assigning peaks in the spectrum to isotope energies from the calibration source 
being used. The provided 152Eu puck is the recommended source to use.

3. There are two methods to manually assign peaks to isotope energies:
a. The first method involves using the spectrum directly. Clicking on the spectrum will open a calibration window for 

the channel number where the cursor was clicked. From this window, the user can assign an energy to the chosen 
channel number. The user should therefore click on the centre of any visible peaks and assign them an energy. 
This energy can either be entered manually or can be selected from the list of peaks the user previously added. Once 
an energy has been chosen, press Apply to assign the energy to the channel number.

b. The second method involves using the table in the Energy Calibration tab. Double-clicking in the Channel column 
of the table allows the user to manually enter the channel number for the corresponding energy. See Section 6.3 for a 
detailed explanation of the Energy Calibration tab.

4.  A minimum of four peaks need to be assigned an energy before the calibration fit is deemed accurate. However, the 
more peaks that are assigned an energy, the more accurate the calibration.
a.  The Calibration Fit tab provides information on the fit parameters and quality of the fit. The calibration curve should 

fit the data points well, and deviation from this likely indicates that the user has assigned the wrong energy to the 
peak. See Section 6.3 for a detailed explanation of the Calibration Fit tab.

NOTE. Determining which peak is associated with which energy can be difficult when the calibration is wrong. A useful tool 
when assigning the peaks of the 152Eu source is to look at the labelled 152Eu gamma spectrum provided in Appendix D.

5.  Once the user has assigned enough peaks and is satisfied with the new calibration, save the new detector calibration 
parameters using the Apply    button in the toolbar menu at the top of the window.

6. Once saved, confirm the new calibration is accurate by pressing the Start   button again and acquiring a new spectrum. 
Any added sources should now be automatically identified. If they are not, start again at Step 1 and repeat the re-
calibration procedure.

NOTE. If the individual energy and FWHM calibration parameters are already known, the detector can be re-calibrated 
without having to follow the steps above. To apply these parameters directly, click the Edit   button in the toolbar menu 
and enter the corresponding values (see Section 6.1).
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6.3.	 Using	the	Energy	Calibration	and	Calibration	Fit	Tabs

The CORIS360® Detector Calibrator tool provides multiple methods for viewing, editing, and analysing a detector’s 
calibration. Two of these methods involve using the Energy Calibration and Calibration Fit  tabs. The primary uses of the 
Energy Calibration tab are to add nuclides that the user is using to check and re-calibrate the detector, and to assign channel 
numbers to the energies of these nuclides. The Info  button displays the energies of the main peaks for the selected source. 
Custom entries into the calibrator table can also be added for scenarios where a source is not present in the drop-down list. 
The entries in the calibration table are coloured either blue or orange, representing whether the energy has been assigned a 
channel number or not, respectively. The tab also provides the user with the ability to plot all of the energies currently in the 
calibration table onto the spectrum above using the Graph All Energies check box. This is a very useful tool when checking and 
re-calibrating a detector.

The primary use of the Calibration Fit tab is to determine the quality of a calibration. In an ideal setup, a calibration fit would 
be perfectly linear, however this is not achievable with scintillator based detectors. Therefore, the aim of the calibration curve 
is to fit the data points as closely as possible. Information on the calibration fit will not be displayed until at least four energies 
have been assigned a channel number. Once a minimum of four calibration points have been added, the tab will provide the 
user with the calibration fit parameters and quality of the fit. This information will be coloured either blue or orange, indicating 
whether the fit is good or bad, respectively. The more energies that are assigned a channel number, the more accurate the 
calibration will be. The Copy Fit Parameters to Clipboard button copies the calibration curve fit parameters (a, b, c) so that they 
can be easily stored, viewed and saved elsewhere.
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6.4. Exporting Data

Once a spectrum has been acquired for checking or re-calibrating a detector, the CORIS360® Detector Calibrator tool provides 
the ability to export the spectrum into a zip file for record keeping and external analysis. A description of each file contained in 
the exported zip file is given below:

To export the spectrum, click File > Export Spectrum from the menu bar in the top left of the window and follow the prompts to 
save the spectrum in the desired location.

Export Information 
.txt file

A text file containing all of the essential calibration session information such as the 
detector name, original and new detector calibration parameters and the nuclides 
used in the calibration.

Export Spectrum 
.csv file

A csv file containing the counts in each energy bin of the spectrum. The first 
column in the file is the energy (in keV) and the second column is the number of 
counts at that energy.

Export Spectrum 
.n42 file

A n42 file containing the same information as the csv file of the same name, 
however the data is in a format that can be readily accessed in spectroscopy 
analysis software.
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Dimensions 210 mm × 425 mm (D × H)  |  8.3” × 16.8” (D × H)

Weight 15 kg  |  33 lbs

Power Supply 100 VAC – 240 VAC (47 Hz – 63 Hz) Input
Provides 24 VDC and minimum 90 W to CORIS360®

Operating Temperature 5 °C – 40 °C (Ambient)  |  41 °F – 104 °F (Ambient)

Storage Temperature 5 °C – 40 °C (Ambient)  |  41 °F – 104 °F (Ambient)

Indoor or Outdoor Use Indoor and outdoor (CORIS360® device is IP54 rated)

Humidity Range Max 70% relative humidity, non-condensing

Altitude Range Max 3000 m

Overvoltage Category OVC II

Pollution Degree Pollution degree II

Detector Type/s Cylindrical Ø1.5” CLLBC Scintillator with SiPM array (CLLBC15, Red)
Cubic 0.5” CLLBC Scintillator with SiPM array (CLLBC05, Blue)

Energy Resolution ~ 4% FWHM @ 662 keV

Energy Range 40 keV to >3 MeV Gamma and Thermal Neutron Detection

Imaging Region of Interest Peaks and non–peaks

Gamma Field of View 360° × 90° (H × V)

Optical Field of View 360° × 90° (H × V)

Max. Angular Resolution 20° ± 1° (CLLBC15 detector)
15° ± 1° (CLLBC05 detector)

Dose Rate Range <0.1 µSv/h – 2 mSv/h  |  <0.01 mrem/h – 200 mrem/h (CLLBC15 detector)
<0.1 µSv/h – 40 mSv/h  |  <0.01 mrem/h – 4000 mrem/h  (CLLBC05 detector)

Radionuclide Identification Customisable library of radioisotopes included

Start-Up Time < 1 minute

Communication Ethernet or Wi-Fi

7.  SPECIFICATIONS
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8.  TROUBLESHOOTING

8.1.	 General

8.2. CORIS360® Is Not Connecting To The Computer

If any unusual error occurs in CORIS360® or the software, performing a full power cycle of the device and restarting the software 
will solve the issue in most cases. To perform this, complete the following steps:

1. Close the software and power off CORIS360® by holding down the power button for 3 seconds.
2. After a few seconds, turn CORIS360® back on and open the software.
3. Check the CORIS360 Status in the bottom right corner of the software window and confirm that it reads “Connected”.

If the error persists following the troubleshooting steps above, please contact the customer support team at  
support@coris360.com.

If CORIS360® cannot connect to the computer, indicated by the CORIS360 Status in the bottom right corner of the software 
window displaying “Disconnected”, some network settings may need to be configured. The cause of a connection issue 
can depend on the CORIS360® firmware version. To determine the firmware version of your CORIS360® device, click on the 
CORIS360 Status, opening the CORIS360 Information window. 

For CORIS360® devices with firmware versions below 1.0.6  

Connection issues will arise when the static IP address to communicate with CORIS360® has not been setup correctly. A static IP 
address will need to be setup for every new computer that connects to CORIS360®, however it will only be required the first time 
a new computer connects to the device. See Appendix A for detailed steps on how to correctly setup the static IP address.

These firmware version do not have a Wi-Fi capability.

For CORIS360® devices with firmware 1.0.6 and above 

The CORIS360® device will automatically assign the IP address to the connected computer. Therefore, no static IP addresses 
should be assigned for either the ethernet or Wi-Fi connectivity. 

If using Wi-Fi, ensure that the computer has been connected to CORIS360® using the Network icon  in the Windows taskbar. 
The name of the network for your CORIS360® device is “CORIS360_<SERIAL NUMBER>”. For example, a device with serial 
number “001C10” will have a network name “CORIS360_001C10”. The serial number of your device can be found on the bottom 
of your CORIS360®. The default Wi-Fi password for your CORIS360® device is “coris360”.

If the error persists and the computer can still not connect to CORIS360®, please contact the customer support team at 
support@coris360.com.
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8.3.	 Spectrum	Energy	Calibration	Appears	Wrong

8.4. Location of Radiation in Gamma Image Does Not Make Sense

If a spectrum is producing a peak at an energy that is known to be incorrect, it is likely that the detector needs to be re-
calibrated. See Section 6 for instructions on how to perform the re-calibration.  

8.5.	 Automatic	Radionuclide	ID	is	Not	Identifying	Peaks

If well-defined peaks are visible in the spectrum but the automatic radionuclide identification is not identifying them, a few 
scenarios could be occurring. 

Firstly, the peak may not be identified because the detector has gone out of calibration. To recalibrate the detector, see  
Section 6. 

Another reason why the peak may not be identified is that the radioisotope belonging to the peak may not be included in the 
software’s radionuclide library. The radionuclide library is fully customisable, with the default library containing 15 common 
radioisotopes that majority of the users will need. If a user requires additional radioisotopes to be included within the library, 
see Section 4.8 for steps on how to customise the library.

Lastly, and least likely, the issue could be due to a reduction in the resolution of the detector due to damage to the detector. 
A reduction in resolution will cause peaks in the spectrum to become wider than normal, increasing their full widths at half 
maximum (FWHM). As stated in Section 7, the provided detectors should have an energy resolution of ~4% FWHM at 662 keV 
peak (137Cs). If the detector resolution has degraded, or if assistance is required for calculating the energy resolution, please 
contact the customer support team at support@coris360.com.

A gamma image created from bad data will produce inaccurate and unstable results. Therefore, conclusions should not be 
drawn from images created from bad data. The Image Quality column in the ROI table provides information on the quality of 
gamma images and therefore their data. It is recommended that no conclusions or interpretations of results are made until the 
gamma image for a ROI achieves an image quality of at least “Good”. 

Some causes for bad data and therefore poor image quality include:

• Too few counts per sample or too few samples in total (see Section 5.1 for further information)
• Selecting a bad custom ROI (see Section 5.2 for further information)
•  Radiation is present outside the 360° × 90° field of view. This may require more samples and/or longer sample times for the 

image capture to produce a good quality image.

Avoiding the causes listed above will result in better quality data and therefore better quality gamma images.

If, after avoiding the above causes, it is still believed that the location of the radiation does not make sense, test the 
performance of CORIS360® using a strong source at a known location. If the radiation is again not present at the known location 
in the gamma image, please contact the customer support team at support@coris360.com.
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9.  CONTACT/SUPPORT INFORMATION

For any assistance regarding the device, its accessories, the software or general questions, please contact the customer support 
team at support@coris360.com. 

Any unauthorised servicing, maintenance or modifications to the device is not permitted. For assistance with any of these 
matters, please contact the customer support team at support@coris360.com. Only qualified personnel from the CORIS360® 
customer support team can perform any servicing, maintenance or modification.
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APPENDIX A . SETTING UP ETHERNET PORT ON COMPUTER

For CORIS360® devices with firmware versions 1.0.6 and above, the system will automatically assign IP addresses and therefore 
automatically connect to the computer being used. For CORIS360® devices with firmware versions below 1.0.6 however, the 
Ethernet port on the computer will need to be set up by assigning a static IP address (IP Address: 192.168.0.1  Subnet Mask: 
255.255.255.0) whenever the user is connecting CORIS360® to a computer for the first time. Assigning a static IP address is 
simple and is required to ensure that the computer can always communicate with CORIS360®. Admin rights on the computer 
are required when setting up an ethernet port.

To set up the computers Ethernet port by assigning a static IP address, follow the steps below:

1. Navigate to Network Connections on the computer by either searching “network connections” from the start menu search 
bar or by navigating to Control Panel > Network and Internet > Network and Sharing Centre and then selecting  
Change adapter settings from the menu on the left of the window. The Network Connections window should look similar  
to the image below.

2.  From here, right-click on the Ethernet connection and select Properties, opening the window shown below.
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3. Select Internet Protocol Version 4 (TCP/IPv4) from the list and click the Properties button, opening the window shown below.

4. Enter the values shown above into the properties window. Specifically, click the Use the following IP address radio button, 
then in the IP address field enter 192.168.0.1 and in the Subnet mask field enter 255.255.255.0.

5. Lastly, click the OK button then close the remaining windows (all windows must be closed before the static IP address will 
assign correctly). The static IP address has now been assigned and the Ethernet port is now set up and ready to connect to 
CORIS360®. 
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APPENDIX B . IMAGE QUALITY METRIC EXPLAINED

Section 5.1 describes the output from the image quality metric and how to interpret its results. This appendix provides some 
information on how the image quality metric works and how the output is calculated. As an overview, the metric works by 
analysing the complexity of the current imaging scenario, then compares this with a lookup table that has utilised millions of 
simulations to describe the relationship between the image complexity and measured counts. This analytical comparison, 
accompanied with monitoring of the convergence of the gamma image, provides a method for calculating the confidence in 
the current gamma image quality. The simulated data takes into account the size and type of detector being used in the system, 
the energy range of the ROI being reconstructed over, and the intensity of the source/s being imaged.
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APPENDIX C . EXAMPLE REPORT
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APPENDIX D . 152Eu GAMMA SPECTRUM



CORIS360® is a product of ANSTO, the Australian Nuclear 
Science and Technology Organisation, with over 70 years 
of experience in meeting the nuclear needs of industry.

This product contains patented technology. Please refer to 
https://www.ansto.gov.au/patents for a full list of patents.

Contact us

For further information on 
CORIS360® including case studies 
and technical reports please visit: 

Website 
www.coris360.com
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+61 2 9717 3311
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